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Computer Requirements

Minimum System Requirements

Computer Platform Processor  Minimum Recommended Available Hard
& Operating System Version Minimum Speed RAM RAM Disk Space*
98, 98SE Pentium 75MHz | 24MB 32MB
; ®
Windows™ g Pentium 150MHz| 32MB 64MB
Operating 2000 Prof | P 133MH SoMB
rofessiona entium z
Systems 64MB 128MB
XP Pentium 233MHz
Mac OS 8.5 -9.2.1
iMac’T\hzipézokm/ (Printing and PC-FAX) | All base models| 32MB 64MB
. meet minimun 30MB
G3/64 Operating | ac 05 X 100,101 |requirements
Systems | printing Only) 128MB 160MB

* You may need more hard disk space depending on what you want to do.
Printer Driver and PC-FAX Driver can be downloaded from http://solutions. brother. com
Note: All registered trademarks referenced herein are the property of their respective companies.




Printer Driver Settings
(Windows® Only)

Using the Brother FAX-1800C Printer Driver

A Printer Driver is software that translates data from the format used by a
computer into the format required by a particular printer, using a printer
command language or page description language.

@ The screens shown in this section are from Windows® 98. The screens on your
PC may vary depending on your Windows Operating System.

For more information, please see the on-line Help in the printer driver.
Paper Tab

The paper tab screen allows you to set up the Paper Size, Paper Source, Paper
Thickness, Orientation, Scaling, and Copy/Page Order.

To access the Brother printer driver, select Print from the File menu. In the Print
dialog box, select Brother FAX1800C from the Name drop down list. Click the
Properties button. The Brother FAX1800C on BRUSB: Properties dialog box will
appear:

Brother FAX1800 C on BRUSB: Properties [z]x]

Paper | Quaily/Calor | Advanced | Suspart |

~Paper Sifa -~

. Letier 8142 ¢ 1.ip & -3
b | D D D ; <> Reger = el
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Legal
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........... Lanscepe .+ | T
2 - - RogiPage Dt ———res St P 2
B o Q — =
s ey R -

About Default
K| gl | i | Wb |

Select the Apply button to apply your selected settings.
To return to the default settings, click the Default button, and then click the
Apply button.

Select the Paper Size and Orientation.
Select number of Copies and Page Order.

Select Paper Thickness, Scaling and Paper Source.
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Paper Size

You can choose from a large selection of standard paper sizes or you can even
create custom sizes ranging form 3.5" X 5" to 8.5" x 14". To select the paper size
you want to use, click the icon.

Paper Size
Letter 81/24 71100

Ad Leqal

N 2
Orientation
Orientation selects the layout of your document on the printed page (Portrait or
Landscape).

Orientation

Partrait Landscape

Copy/Page Order
Copies

Select the number of copies that will be printed.

Collate

With the collate check box selected, one complete copy of your document will
be printed and then repeated for the number of copies you selected. If the collate
check box is not selected, then each page will be printed for all the copies
selected before the next page in the document is printed.

Reverse Order

Reverse Order prints the pages of your document in the opposite order.

Copy/Page Order

Copies:

[ Collate W
hE i
[ Reverse Order
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Paper Thickness

This setting provides the best positioning of the paper for printing. Depending
on the thickness of the paper you are using, you can improve the quality of your
output by selecting the appropriate thickness:

Regular
Thin
Thick
Thicker

For example if you are printing on thin paper, select Thin as the Paper
Thickness to get the best paper handling and output for that paper type.

FPaper Thickne:

<3/'> IHeguIar ’I

Scaling

The Scaling feature reduces or enlarges your document from 50% to 200%.
From the pull-down box, select from the preset settings or type a percentage
setting. You can also select 2 in 1 printing for printing two pages on one sheet
of paper.

For Windows® 2000 Professional, you can also select 4 in 1 printing.

Scaling
100 2in1
I'Iin'l[1DEI°/=] 'I

Paper Source

From the Paper Source pull-down, choose the source of the media you are using.
Feeder

Manual Feed

FPaper Source

_@ IFeeder 'I

.
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Quality/Color Tab

The Quality/Color tab screen provides Quality, Media type, Document type,
Color/Mono settings, Bi-directional Printing settings and Fast Draft Mode. All
of these selections are designed to offer the best quality output for your

document.
Brother FAX1800C on BRUSB: Properties [7]
Paper  Qualiy/Colar | advanced | Support|
r~ Calor/Mono
£ @
S|
Draft Mormal Fine: Super Fine Colar tona
~ Media i~ BiDirectional Printing
Plain Paper 'I ¥ BiDirectional Printing
~Fast Draft Mo
i) ™ East Draft Mode
g
Auta Phata Graphics Custom
el i [ L= e |
MFC will stop CalorMona print operations when one ar
more of the ink cartridges are emply.
Default

Concel | sl | Hem |

Select the Apply button to apply your selected settings.
To return to the default settings, click the Default button, and then click the
Apply button.

Quality

The quality selection allows you to choose the print resolution you want for your
document. Print quality and speed are related. The higher the quality the longer
it will take to print the document. The quality selections available will vary
depending on the media selection.

Draft: The fastest print mode and the lowest ink consumption. Use this mode to
print large volume documents or a document for proofing.

Normal: Recommended for ordinary printouts.

Fine: Better print quality than normal mode and faster print speed than Super
Fine.

Super Fine: Use this mode to print precise images such as photographs. Since
the print data is much larger than normal mode, the processing time, data
transfer time and print time will be longer.
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Media

To achieve the best print results, select the media being printed on should be
selected in the driver. The Brother machine changes the way it places dots,
depending on the selected media type.

Paper Type Recommended Print Quality
Plain Paper Normal
Inkjet Paper Fine
Glossy Paper (4 color) Super Fine
Glossy Paper (3 color) Super Fine
Transparencies Fine
Transparencies (mirror) Fine

The print quality of black ink varies depending on the kind of glossy paper you
are using. Black ink is used when you select Glossy Paper (4 color). If the
glossy paper you are using repels the black ink, select Glossy Paper (3 color),
which simulates black ink by combining the other three ink colors.

Document

The printer driver will select the most suitable color matching method,
depending on your document type. Generally, text and business graphics are
printed vividly and photographic images are printed softly.

Auto: The printer driver automatically selects the document type.
Photo: Use this mode for photographic images.

Graphics: This mode is for documents that contain text or business graphics
(charts or clip art).

Custom: Select this mode if you want to manually select the color matching
method and halftone method.
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Color Matching

You can select the color matching method yourself. Select the best one for your
document.

Match Monitor
Suitable for photographic images. Color is adjusted to get the closest color
match to the PC monitor.

Vivid Color
Suitable for business graphics such as charts, graphs, and text. The color is
adjusted to give more vivid color.

Golor Matching

I~ ICk
& Match Monitor
{+ Fiatch Mianitari
o T Hathlonoit
 Wivid Golor
" Mone I Hene
i Cancel | Default | 0K | Cancsl | Defult |
(For Windows® 98/98SE/Me) (For Windows® 2000 Professional)

Custom Setting

You can customize your settings by selecting the type of Halftone or Color
Enhance/True2Life.

Color Control x|
i Colar Enhanc
I™ Color Enhance/True2Lite 0N
Sharpress ==
Color Densiy (| ——f——
White Balange 1 ——f——
20 0«20
Brightness ol |
—Half Tane Pattem (et t ;I —’I
& Photo Fied o) Bl
Green i) & r
© Cluster _I _I
Blue ol |
{HRTY Cancel Default I Help | About |
Click here to accept the current seting and quit,

Halftone Pattern

The Brother machine can use several methods to arrange where to place dots to
express halftones. There are some predefined patterns for placement of dots and
you can select which one is used for your document. Select the appropriate
method.

Photo

This method creates smooth halftones suitable for photographic images. It takes
more time to process data, but it expresses more levels of halftones and creates
more natural images.
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Cluster
This is suitable for business graphics such as charts, graphs and drawings, since
this creates sharper printouts. Moreover, the processing time is shorter.

Color Enhance

Selecting Color Enhance/True2Life ON enables the True2Life feature. This
feature analyzes your image to improve quality sharpness, white balance and
color density. This process may take several minutes depending on the size of
the image and the speed and RAM memory of your computer.

Color Enhance/True2Life ON
Adjusts the color in the image for better print quality. Print time will be longer
with True2Life set to ON.

Sharpness

This setting enhances the detail of an image. This is similar to adjusting the fine
focus of a camera. If the focus is off a little you will not be able to clearly see
the fine details of an image.

Color Density

This adjusts the total amount of color in the image. You can increase or decrease
the amount of color in an image to improve a picture that may appear washed
out or weak.

White Balance

This adjusts the hue of the white sections of an image. Lighting, camera settings
and other influences will effect the appearance of white. The white parts of a
picture may appear to be slightly pink, yellow or some other color. By using
this adjustment you can correct this effect and bring the white sections back to
pure white.

Brightness

Change the brightness of the whole image. Moving the scroll bar to the left
makes your image darker and moving the scroll bar to the right makes your
image lighter.

Contrast

Change the contrast of an image. Darker sections will be darker and lighter
sections will be lighter as you increase the contrast. Increase the contrast when
you want an image to be clearer. Decrease the contrast when you want an image
to be more subdued.

Red
Increase the intensity of the Red color by adding red to the whole image.

Green
Increase the intensity of the Green color by adding green to the whole image.

Blue
Increase the intensity of the Blue color by adding blue to the whole image.
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Color/Mono

This selection allows a color document to be printed in mono only.

Color/Maono

Color tono

Bi-Directional Printing

When Bi-Directional Printing is selected, the print head prints in both directions
and offers faster print speeds. When it is not selected the print head prints in one
direction only and provides higher print quality.

Fast Draft Mode

You can print much more quickly, than mono draft mode, by using both black
and cyan ink.

Advanced Tab

1-8

Biother FAX1800C on BRUSB: Properties

Paper | Qualty/Coker Advanced | Suppart|
—LE“H SR I Hise Watemark I~ Inbackgound
Select watemak
1 Edit
: COPY
[P DRAFT Delate.
- - Hew
“ Custom Page Setting
Page Tide
EEE
-~ Pint Watemark o= |
On al pages 2
Default
0K | cancel | aeob | Heb |

Select the Apply button to apply your selected settings.
To return to the default settings, click the Default button, and then click the Apply button.

Change the tab settings by selecting one of the following icons:
Watermark

Device Options

Watermark

To place a logo or text in your document as a Watermark, use a bitmap file or
text you created as your source file or select one of the preset Watermarks.

PRINTER DRIVER SETTINGS (WINDOWS®ONLY)



Print Watermark

The Print Watermark feature offers the following print choices:
On all pages

On first page only

From second page

Custom

In Background

With the In background feature checked Watermark will print on the page
behind your document. If this feature is not checked then the Watermark will
print on top of your document.

Watermark Style

You can change the Watermark’s size and position on the page by selecting the
Watermark and clicking the Edit button. If you want to add a new Watermark
click the New button, and then select Text or Bitmap in the Watermark Style.

Watermark Text

Enter your Watermark text into the Text box, and then select the Font, Size,
Color and Style.

Watermark Bitmap

Enter the file name and location of your bitmap image in the File box or Browse
for the file location. You can also set the scaling size of the image.

watermark Setting
T

Letter 8142411 in [ [CONFIDENTIAL E|

mark Teat

[CONFIDENTIAL

[« | Font sl =
| See 72 3 St [Regar -

g
...... : oo B[ choomecan
I~ iiEaicaly e e FE
5

| R —
Caneel Help

Position

The position settings offer controls for where the Watermark will be positioned
on the page.
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Device Options
Set the Print Date & Time in Printer Function:

Brother FAX1800C on BRUSB: Properties 7] x]
Paper | Qualty/Color  Advanced |Suppolt|
Finter Function
i~ Date & Tims
[~ Enable
Seting)
Default
O e =

Print Date & Time
When enabled, the Print Date and Time feature will print the date and time from
your computer’s system clock on your document.

Date & Time [x]

Format
Diats

Time

Date & Tims
Pasitian

 Leit " Center " Right

Eeifs)s
s Lol
® [ Top Bottom

% Transparent

me | Concel | Defaut |

- Background

Click the Setting button to change the Date and Time Format, Position and Font.
To include a background with the Date and Time, select Opaque. When Opaque
is selected, you can click the Color button to change the color of the background.

@ The Date and Time in the selection box shows the format that will be printed.
The actual Date and Time printed on your document will be retrieved from the

settings of your computer.
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Support

The Support Tab provides driver version and setup information. In addition there are
links to the Brother Solutions Center and Driver Update Web sites.
Click the Support tab to display the following screen:

Brother FAX1800C on BRUSE: Properties K

Paper | Qualtp/Celor | Advanced Support |

Printer Driver

m Brother Solutions Center

FAX 1800C Connent diectl to the Brother Solutions Center
\uéeh [solutionsbrother.con sie for up to date
information on device difvers, Lser guides, while
Version 1.00.00 for Windows35/38/Me papers and other documentalion avaiable for your
Brother praduct

17 dhpr 2000

0]

wieb Update

@ Brother Industries Ltd, 1993 - 2001
All rights Reserved,

0k | cancel Sl Help

Web Update

Web Update checks the Brother web site for updated drivers, and then it
downloads and updates the printer driver on your computer.

Brother Solutions Center

The Brother Solutions Center is a Web site offering information about your
Brother product including FAQs, User Guides, Driver Updates and Tips for
using your machine.
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Using the Brother Machine
as a Printer

Features

The FAX-1800C offers many features you’ll find in a high quality ink jet
printer.

Fast Printing Speed—Using Draft mode, you can print up to 8 pages per
minute in full color, and up to 10 pages per minute in black.

Brilliant High Quality Output—Printing at 2400 x 1200 dpi resolution on
glossy paper gives you highest resolution output.

Beautiful Elaborate Output—You can utilize 2 in 1, watermark printing,
True2Life technology, and other features for making beautiful outputs.

Low Running Cost—Whenever you run out of a color ink, you’ll replace only
the cartridge that is empty.

USB (Universal Serial Bus)—Interface allows for fast comunication with your
computer.

Straight Paper Path—The machine can use various types of paper: plain
paper, Ink Jet Paper, glossy paper, transparencies, and envelopes. Using the
appropriate paper reduces the occurrence of paper jams. For complete
information about the kinds of paper to use with the machine, please read
Chapter 3 in the Owner’s Manual.

Printer Driver

2-1

You can change the following printer settings when you print from your
computer:

Quality (Speed) /Media
Color Matching

Halftone

Color Enhance/True2Life
Fast Draft Mode
Watermark

Print Date & Time
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Choosing the Right Kind of Paper

To achieve high quality printing using your machine, it’s very important to
select the right kind of paper. Be sure to read “About Paper” on page 3-1 of the
Owner’s Manual before you select and purchase paper.

Multi-purpose Sheet Feeder

The multi-purpose sheet feeder can feed plain paper, inkjet paper, glossy paper,
transparencies and envelopes. When the machine receives data from your
computer, it begins the print process by feeding paper from the multi-purpose
sheet feeder.

After you select the print command from your PC, the print process begins:

Your PC sends a print command and data to the machine, the LCD shows
RECEIVING DATA.

If there are more pages, the machine begins to print the next page automatically.

When the machine finishes printing all data, it returns to display the date and
time.

You can select the paper source, paper size, and orientation in your application
software. If your application software does not support your custom paper size,
select the next larger paper size. Then adjust the print area by changing the right
and left margins in your application software.
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Simultaneous Printing/Faxing

Your machine can print data from your computer while sending or receiving a
fax, or while scanning information into the computer. However, when the
machine is copying or receiving a fax on paper, it pauses the PC printing
operation, and then resumes printing when copying or fax receiving is finished.
Fax sending will continue during PC printing.

The Ink Key

When you press Ink, the LCD shows:

If you are having trouble with one of the
ink colors, you may need to clean the
print head. (See Cleaning the Print Head
in the Owner’s Manual, page 15-9.)

If you got the error message NEAR EMPTY or INK EMPTY, you will need
to replace the ink cartridge for the appropriate color.
(See Error Messages in the Owner’s Manual, page 15-1.)

Stop/Exit Key

If the LCD shows REMAINED DATA, you can clear data left in the printer
memory by pressing Stop/Exit.

Checking the Print Quality

If you want to check the print quality and find out how to improve it, see How
to Improve Print Quality in the Owner’s Manual, page 15-9.
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Print Area

The print area depends on the settings in the application you are using. The
figures below show the unprintable areas on cut sheet paper and envelopes.

Cut Sheet Paper Envelopes
@ ® @
o} ®}
O
HO) 1@
unprintable area
(inches)
Paper Type | Paper Size © 2 (3) )
Fax
Mono
Copy
Cut Sheet Letter, Legal 0.12 | 043 | 025 0.25
Color
Copy
Printer
Executive Printer 0.12 0.43 0.13 0.13
Envelopes Printer 0.39 0.79 0.13 0.13

@ Printer depends on the Printer Driver.
The above figures are approximate and the print area may vary depending on
the kind of paper you are using.

@ Do not use the following types of paper and envelopes:

Damaged, curled, wrinkled, or irregularly shaped paper and envelopes

Extremely shiny or highly textured paper and envelopes

Envelopes with clasps

Envelopes of baggy construction

Envelopes not sharply creased

Embossed envelopes

Paper and envelopes already printed with a laser printer

Envelopes preprinted on the inside

Paper and envelopes that cannot be arranged uniformly when stacked

USING THE BROTHER MACHINE AS A PRINTER



Using PC-FAX

(Windows® Only)

PC-FAX Sending

The Brother PC-FAX feature allows you to use your PC to send a file. You can
create a file in any application on your PC, and then send it as a PC-FAX. You
can even attach a cover page note. All you have to do is set up the receiving
parties as Members or Groups in your PC-FAX Address Book. Then you can
use the Address Book Search feature to quickly find them to address your faxes.

PC-FAX is available in Black & White only.

Setting Up the User Information

From the Start menu, select Programs, Brother, Brother MFL Pro Suite, and
then select PC-FAX Setup.

@ You can access the User Information from the FAX Sending dialog box by clicking

3-1

% . (See Sending a File as a PC-FAX Using the Facsimile Style, page 3-12.)

The Brother PC-FAX Setup dialog box will appear:

Brother PC-FAX Setup

User Infarmation | Sending I Speed Dial [Facsimile style only] I

Name: [abn Doe
Company: IInternationaI Spring Board Assoc.
Department: |L|55

Phone Mumber: |908-555-1 212

Fan Mumber: ISDS-555-1 22

E-mail |J Doe@springboard. org
Address 1: [123 Riase Hil Driver
Address 2: [Patsville, M) DE03

ak I Cancel I

This information is required to create the Fax Header and Cover Page so you
must enter it.

To save the User Information, click OK.
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Setting Up Sending

To access the Sending tab from the Brother PC-FAX Setup dialog box, click the
Sending tab.

Brother PC-FAX Setup H

Uzer Information Sending | Speed Dial (Facsimile style only) I

Dial Setting

Outzide line access: IEI

Header

Ird Include header

Addrezsboak file

IC[\WINNT\SYSTEM32\address.ba2 Browse |

User interface

" Simple style

' Facsimile style

oK I Cancel

Outside Line Access

If you need to enter a number to access an outside line, enter it here. This is
sometimes required by the local PBX telephone system.

Include Header

To add header information to the top of the fax pages you send, check the
Header box.

Address Book File

You can select different database files to use with the Address Book. You must
enter the path and file name of the database file or use the Browse button to find
the file so you can select it.
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User Interface

Select the User Interface in the Sending tab. You can choose the Simple Style
or the Facsimile Style.

Simple Style

Brother PC-FAX

BEE

—
—

Facsimile Style

I e ————————————————————————————— I-E;i : ‘-:é-_.
- ﬂ Cover Page On (P)

O |

Speed Dial
1 (2 3 02050040050
4 5§ ¢ e
.Pause ) .Redial (R)

ﬂ n . Clear (L) . Address Book
(0
000 - =
| Stop (%) Start (0)
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Setting Up Speed Dial

Access the Speed Dial tab from the Brother PC-FAX Setup dialog box by

clicking the Speed Dial tab. (To use this feature you must select the Facsimile

Style user interface.)

Brother PC-FAX Setup HE
User Information I Sending  Speed Dial (Facsimile style anly) I
Address Book Speed Dial
Mame | Fax Mo | MHame | Fax
T8 Sales 31 Joe Smith 905-555-"
ﬂ Joe Smith 908-555-123 ﬂ 2 John Roller 308-704-1
E John Raller 908-704-231
4 | © 4] | |
Add > Chear |
oK I Cancel |

You can register any address or group on one of the ten Speed Dial buttons.

To register an address in a Speed Dial location:

Click the Speed Dial location you want to program.

Click the person or group you wish to assign to the Speed Dial location.

Click Add >> to program the Speed Dial location.

To clear a Speed Dial location:

Click the Speed Dial location you want to clear.

Click Clear.
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The Address Book

From the Start menu, select Programs, Brother, Brother MFL Pro Suite, and
then click Address Book.

The Brother Address Book dialog box will appear:

i;" Brother Address Book M=l
File Edit Help
[ i
Marne | Fax I E-mnail
!ESales
E Joe Srith o053-555-1234

905-70
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Setting Up a Member in the Address Book

In the Brother Address Book dialog box you can add, edit and delete stored
information for members and groups.

In the Address Book dialog box, click the icon to add a member.

The Brother Address Book Member Setup dialog box will appear:

Hame: E IJoe Srnith Title: IMr—
Company: IBorther Internationl Corp.
Department: ISaIes Job Title: W
Street Address: I‘I 00 SomeStreet
Lty I— State/Province: INJ—
Zip Code/Post Code: IDS%?— Country/Begion: LSA
Buzinesz Phone: IW Home Phone: l—
Fax: IW M abile Phore: I—
E-Mail: |ioe.smith@"""“".com
MFCE-mall Addiess: |

ITI Cancel |

In the Brother Address Book Member Setup dialog box, type the member’s
information. Name and Fax are required fields. Click OK to save the member’s
information.
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Setting Up a Group for Broadcasting

If you repeatedly send the same PC-FAX to multiple recipients, you can
combine members into a Group.

In the Brother Address Book dialog box, click the icon to create a group.
The Brother Address Book Group Setup dialog box appears:

Brother Address Book Group Setup

Group Hame ﬁ |Sales
Aailable Mames Group Members
Joe Smith
John Roller
>
Add > | << Bemove I
()8 I Cancel I

Type the name of the new group in the Group Name field.

In the Available Names box, select each member to be included in the Group,
and then click Add >>.
Members you add to the group will be listed in the Group Members box.

After all the members have been added, click OK.

Editing Member Information

Select the Member or Group you want to edit.

Click the edit icon.

Edit the Member or Group information.

Click OK to save your changes.
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Deleting a Member or Group

Select the Member or Group you want to delete.

Click the delete @ icon.

Click OK when the Delete OK? dialog box appears.

Exporting the Address Book

You can export the Address Book to an ASCII text file (*.csv). If you wish, you
can create a Vcard for selected members that will be attached to all the sender’s
outgoing e-mail; a Vcard is an electronic business card that contains the sender’s
contact information.

To export the current telephone book:

M If you are creating a Vcard, you must first select the member.

From the Address Book select File, point to Export, and then click Text
—OR—Click Veard and go to Step 5.

Select the data fields you wish to Export from the Available Items column, and
then click Add >>.

@ Select items in the order you want them listed.

If you are exporting to an ASCII file, select Divide Character - Tab or
Comma. This selection inserts a tab or comma between each data field when it
is Exported.

Select OK to save the data.

Select Items

Select items in the order you want to list.
You cah select the separator character to be inzerted between items.

Luvailable [tems Selected ltems

Mame -
Title:

Compary

Department add x> |
Job Titlet

Street Address

City

State/Pravince LI
Zip Code/Past Code [GETIE
Countre/Region

Business Phone LI

 Divide Character

& Tah

" Comma Ok I Cancel |
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Type the name of the file, and then select Save.

Save As 2] x]

Save jn:l@ My Documents j gl

File name: | Save I
Save as ype: IText file: §* o} j Cancel |
4

@ If you selected Vcard in Step 1, the Save as type: will be Vcard (*.vcf).

Importing to the Address Book

You can import ASCII text files (*.csv) or Vcards (electronic business cards)
into your Address Book.

To import an ASCII text file:

From the Address Book select File, point to Import, and then click Text

—OR—Click Veard and go to Step 5.
B

Select Items

Select the fields from the Available ltems list in the zame order they are listed in the

Irport text file.
“r'ou musgt select the separator character uged in the Import text file.

Awailable [tems Selected ltems

BEME oo
Title

Company

Department Add x> |
Job Title

Street Address

City
State/Province << Remove |

Zip Code/Post Code
Country/FRegion
Businezz Phone LI

— Divide Character

& Tab

€ Comma ()8 I Cancel |

Select the data fields you wish to Import from the Available Items column, and
then click Add >>.

@ Select the fields from the Available Items list in the same order they are listed
in the text file to be imported.
Select Divide Character - Tab or Comma based on the file format you are

importing.
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Select OK to import the data.
Type the name of the file, and then select Open.

Look jr: I ﬁ My Docurments j gl

File rame: || Open I
Files of type: IVcard = vef} j Cancel |
4

@ If you selected a text file in Step 1, the Files of type: will be Text file (*.csv).

Setting Up a Cover Page
Access the Brother PC-FAX Cover Page Setup from the FAX Sending dialog
box by clicking EJ . (See Sending a File as a PC-FAX Using the Facsimile Style,

page 3-12.)
The Brother PC-FAX Cover Page Setup dialog box will appear:
i Brother PC-FAX Cover Page Setup E
¥ Cover page On
Ta Comment Clear |
Mame : IJ oe Smith
Department : ISaIes
LCompany : IBorther Intermationl Carp.
AED — Farm
Mame : ITaro Magapa
& Type 1 © Type 2
TEL IDT 23-456-7850
o Im 23-456-7330 ¥ Import BMP file Browse. |
E-Mail: Iabcd@efgd.co.ip File name CWRPAGE.EMF
Diepartment : ISaIes Alignment & Left
' Center
Company : IBortherIntemationI Corp © Right
Address] IKawaglsw 939  \wWallpaper
Address2 : IMIZUHD MAGOYA ¥ Count cover page

Preview.. | Drefault | Ok I Cancel |
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To
You can enter information in each field.

If you are sending a fax to multiple recipients, the recipient information will not
be printed on the Cover Page.

From

You can enter information in each field.

Comment

Type the comment you want to add to the cover page.

Select Cover Page Form

Select the cover page form you want.

Import BMP File
You can insert a bitmap file, such as your company logo, in the cover page.

Select the BMP file by using the browse button, and then select the alignment
style.

Count Cover Page

‘When the Count Cover Page box is checked, the Cover Page will be included in
the page numbering. When this box is not checked, the Cover Page will not be
included.
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Sending a File as a PC-FAX Using the Facsimile Style
1 Create a file in Word, Excel, Paint, Draw or any other application on your PC.

2 From the File menu, select Print.
The Print dialog box will appear:

= |

7 Select Brother PC-FAX as your printer, and then click OK.
The FAX Sending dialog box will appear:

brother

ﬁ Cover Page On {P)

Speed Dial
£ 8 8 ==k
4 15 1 o s
.Pause ) .Redial (R)

ﬂ ﬂ . Clear (L) . Address Book
(D
08 e
| Stop (X) Start (O)
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Enter the fax number by using any of the following methods:
Enter the number using the dial pad.
b. Click any of the 10 Speed Dial buttons.

c. Click the Address Book button, and then select a Member or Group from
the Address Book.

If you make a mistake you can click Clear to clear all the entries.

To include a cover page, click { s Cover Page On, and then click the Cover

Page icon to enter or edit the cover page information.

Click Start to send the fax.

If you wish to cancel the fax, click Stop.

Redial

If you want to redial a number, click Redial to scroll through the last five fax
numbers, and then click Start.

Sending a File as a PC-FAX Using the Simple Style
Create a file in Word, Excel, Paint, Draw or any other application on your PC.
From the File menu, select Print.

The Print dialog box will appear:

Print ﬂ E
r~ Printer
Mame: Brother PC-Fas Properties: |

Status: Ready

Type: Brother PC-Fii

Wwhere:  BRUSE:

Comment: ™ Print b file

— Print range Copie:

&l Mumber of copies: |1 3:
" Pages [rom:|1 !D:I_
) Selection Iﬁl J= | Collate

Ok I Cancel |
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Select Brother PC-FAX as your printer, and then click OK.
The FAX Sending dialog box will appear:

Brother PC-FAX HE
‘ ‘
¥ Cowver page On [

Ta | I
Clear |

In the To: field, type the fax number of the receiving party. You can also use
the Address Book to select destination fax numbers. If you made a mistake
entering a number, click the Clear button to clear all entries.

To send a Cover Page and note, check the Cover Page On check box.

@ You can also click the icon to create or edit a cover page.

When you are ready to send your fax, click the Send icon.

If you wish to cancel the fax, click the % icon.
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Using the Brother Machine
with a New Power Macintosh®
G3, G4 or iMac™/iBookm™

Set Up Your USB-Equipped Apple®
Macintosh® G3, G4 or iMac™ or iBook™ with
Mac OS 8.5/8.5.1/8.6/9.0/9.0.4/9.1/9.2.1

Before you can connect the machine to your Machintosh®, you must purchase
a USB cable that is no longer than 6 feet (1.8 meters).

To work with your machine, your USB-Equipped Apple® Macintosh® must be
set up with Mac OS 8.5/8.5.1/8.6/9.0/9.0.4/9.1/9.2.1.

Using Brother Printer Driver with Your Apple®
Macintosh®

To select the Printer:

From the Apple menu, open the Chooser.

O0=——————  (hooser=—"———H5

Connect to:
FAX -KERLK

¥
&

5

00/

1

L Pro

>
o

pleShare HL-1

&
o

@

HL-1440/50/70N  HL-1850/1670N

&
(5

Laser'writer 300/L5  Laserwriter &

]
a
w
in
]
]

=
f}
=
o
=
a
o
=
k=)
-

Background Printing: @ On (O Off

() Active
@ Inactive 7.6.2

I=| | AppleTalk

Click the MFL Pro Color icon. On the right side of the Chooser, click the
printer you want to print to. Close the Chooser.
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To print the document:

From application software such as PaperPort®, click File menu and select Page
Setup. Change the settings for Paper Size, Paper Thickness, Paper Source,

Orientation, and Scaling, and then click OK.

Orientation : @ T@ Scaling : %

Paper Thickness
Paper Source

brother Fax-1000x 154
Paper Size: @ Letter O A4
{J Legal A5

3 Executive 2| Post Card hd

From application software such as PaperPort, click File menu and select Print.

Click Print to start printing.

brother Fax-x0xx 160 =
Output:
Copies: EI _
Pages: @ All ) From: |:| To: I:I
Quality: ) Draft @& Normal ) Fine () Super Fine Address
Media Type : | Plain Paper - | m
Color/Mono : @ ] Fast Draft Mode

Color  Mono [ Save Settings ] [ Default ]

@ If you want to change Copies, Pages, Quality, Media Type and Color/Mono,

select your settings before clicking Print.

Option Setup allows you to change Document and Printing Options.

Option Setup

Document :

Auto Photo Graphics Custom

Color Matching
Custom Setting

B4 Bi-Directional Printing

Default

USING THE BROTHER MACHINE WITH A NEW POWER MACINTOSH®G3, G4 OR IMAC™/IBOOK™
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Sending a Fax from Your Macintosh®
Application

You can send a fax directly from your Macintosh® application using the
following steps:

Create a document in a Macintosh application.

To begin the fax transmission, select Print from the File menu.
The Printer dialog box appears:

brother Fax-x00x
output
Copies: EI

Pages: @& All O From: I:I To: I:I
Quality: () Draft @& Normal () Fine ) Super Fine Address
Media Type : |Plain Paper v|
Color/Mono : @ [ Fast Draft Mode

Color Mono [ Save Settings ] [ Default ]

When Printer is selected, the top button shows Print and the Address button is
grayed.

From the OQutput pull-down menu, select Facsimile.

brother Fax-xoxx 160
[ Send Fax |
.
copies: ~  ———
Pages: @& All O From: D To: I:I Option...
Quality: Draft Normal Fine Super Fine
Media Type : |Plain Paper v|
Color/Mono : @ Fast Draft Mode
Color Mono Save Settings

When Facsimile is selected, the top button shows Send Fax and the Address
button is available.
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Click Send Fax.
The Send Fax dialog box appears:

Send Fax
Input Fax Number : Destination Fax Numbers :
Stored Fax Numbers : [t
Barble 908-477-8888(~ | T
Bob 908-869-8888
Frank 908-236-8888
Tony 908-569-8888
New e | [ vetete | (s ] ([ Cancel ) (Senarar]

The Send Fax dialog box has two list boxes. The left box shows all the
previously Stored Fax Numbers; the right box will show the Destination Fax
Numbers as you select them.

To address the fax, type a fax number in the Input Fax Number box.
—OR—

Select a name/number from the Stored Fax Numbers box, and then click
[ 1. Your recipient will appear in the Destination Fax Numbers box.

@ You can select several stored numbers at once by using the Shift and Ctrl keys.

If you want to, you can add your new recipients to the Stored Fax Numbers at
this time by clicking New. (See Adding a New Member, page 4-5.)

— OR—

You can add a new group by clicking Group.

(See Adding a New Group, page 4-6.)

If you are finished addressing your fax, click Send Fax.

ﬂ To select and send only certain pages of the document, click OK to return to
the Print dialog box.

@ If you click Send Fax without addressing your fax, the following error message
appears:

Mo fax number is selected!
& Click OK to continue, and then select the

Destination Fax Numbers.

Click OK to return to the Send Fax dialog box.
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Setting Up Your Address Book

You can add new members and groups to your Address Book, even while you
are addressing a fax.

Adding a New Member

To add a new member to the Address Book, in the Facsimile dialog box click
Address.
The Address Book dialog box appears:

Address Book
Stored Fax Numbers :
Barbie 908-477-8888| ~ |
Bob 908-869-8888
Frank 908-236-8888
Tony 908-569-88838

New ] [ Growp J [ Edit | [ Delete

Click New. The following dialog box appears:

Name : || | _ox |
Faxs : | |
Memo : | |

Type the name and fax number.
If you want to, you can store a comment in the Memo field (up to 15 characters).

Click OK to return to the Address Book dialog box.
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Adding a New Group
You can set up a group of multiple recipients.

Click Group.
The Group Setting dialog box appears.

Group Setting
Group Name :
Stored Fax Numbers ; ‘TEﬂlﬂl
Barbie 908-477-SE5G(~ | [=|
Bob 908-869-23%
Tony 908-569-5%F57 E
Frank 908-236-£8E5 E]

(o) 2]

In the Group Name field, type a name for your Group.

From the Stored Fax Numbers box select the

then click [_=_].

recipients for your Group, and

Your selection will appear in the box under the Group Name field.

Click OK.
The Address Book dialog box reappears:
Address Book
Stored Fax Numbers :
Team1 (GROUP) [=]
Barbie 908-477-8888
Bob 908-869-8888
Frank 908-236-8888
Tony 908-569-8888
e Con | (oo
Click OK.
The Print/Facsimile dialog box reappears:
F AX-XXXXX
Srother 15 Senarax
C 1
Copies : ance ______
Pages: @ All & From : D To: l:l
Quality: ) Draft @ Normal (0 Fine 73 Super Fine
Media Type : |Flain Paper - | _m
Color/Mono : [ Fast Draft Mode
Color Mono [ Save Settings ] [ Default ]

If you are ready to send your fax, click Send Fax.
(Follow the steps on page 4-3 for sending a fax.)
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